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Disclaimer 
 

The intent of the DS3000 Storage Managers Demo software and this Demo Guide document is to provide 
IBM field sales and support personnel, IBM Business Partners, and their resellers, distributors and 
integrators a tool for illustrating the features, functions and power of the DS3000 Storage Manager 
software.  

At the time these tools are released and internally distributed, there were only minor errors that do not 
result in intentional misrepresentation of the DS3000 Storage Manager or DS3000 disk systems 
capability.  However, the Demo is neither tested, nor updated, nor maintained to the extent of the actual 
products offered for sale or other customer use.  As a result, certain features and functionality may not 
behave as they would in a production release of DS3000 Storage Manager.  

Technical questions should be verified through official published documents, support resources, or 
directed to appropriate Systems Engineers, field support or customer service personnel.  
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Getting Started 
 
Audience 
Welcome to the DS3000 Storage Manager Demo Guide.  

The audience for this demo guide is technically-oriented members of the sales community who hope to 
understand more about how the DS3000 Storage Manager works.  This guide is also for members of 
Field Sales wishing to use this tool to demonstrate capabilities of the DS3000 disk systems. 

 
Background Information 
The DS3000 Storage Manager Software Demo is designed for use in testing environments as a stand-
alone simulator of DS3000 Storage Manager’s functions.   

To prevent accidental access or corruption of critical data, the Storage Manager Demo does not have the 
ability to access actual storage disk systems.  

 

Prerequisites 
The Storage Manager Demo program runs on Windows 2003 or XP environments.  Other environments 
have not been tested nor are they approved for use. 

 

Terminology 
Before we begin our journey though the DS3000 Storage Manager, there is some terminology you may 
not be familiar with. We will provide you with a short summary of these terms. 

Array: A set of physical drives logically grouped together with an assigned RAID level.  Arrays can vary in 
the number of drives to meet required data protection, capacity, or performance requirements (the more 
physical drives in an array, the higher the performance capability of the array). 

FlashCopy: This feature provides the ability to create a point-in-time image of a logical drive. It is very 
useful for as a data source for backup applications. 

Host-to-Logical-Drive-Mappings: When there are several hosts and many logical drives to associate to 
these hosts, Host-to-Logical-Drive-Mappings are utilized to configure a set of logical drives to each host 
server. We use the partitioning feature to assist in this process 

Logical Drive: This is the basic storage unit that is created on the DS3000 and presented to a host server. 
It is synonymous with LUN and is a drive letter (H: for example) in Windows environments. 

Partition: This premium feature logically divides a single disk system into multiple systems by defining 
which host or host group can access each logical drive. This enables a range of hosts with different 
capacity, performance, or data protection demands to effectively share a single storage system. 

Storage subsystem:  This term will be used interchangeably with disk system.  Both refer to the DS3000 
series disk systems which are managed by the DS3000 Storage Manager 

VolumeCopy: This feature provides the ability to create an independent copy of another logical drive or 
FlashCopy. This term is also used interchangeably with logical drive copy. 
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Loading the Software 
The Storage Manager Demo program is available from a variety of sources including  

 CDs 
 IBM Internal Sales Kit: 

http://w3-
1.ibm.com/sales/systems/portal/_s.155/254?navID=f220s240&geoID=All&prodID=Disk&docID=ds30
00sk.skit&docType=SalesKit&skCat=DocumentType)   

 External PartnerWorld Kit:  
http://www-
1.ibm.com/partnerworld/sales/systems/myportal/_s.155/307?navID=f220s240&geoID=All&prodID=Di
sk&docID=ds3000sk.skit&docType=SalesKit&skCat=DocumentType 

 

The Demo is zip file with the following name SMdemo_217_G506.zip. Unzip this file into a folder of your 
choice.  Within this folder will be the DEMO folder.  Simply navigate there and execute the batch file 
named Start_Demo.bat. 

And you are ready to go! 

__________________________________________________________________________________ 

Note: When the installation of the Storage Manager Demo is completed, go to the directory where the 
demo was installed and execute the Start_Demo.bat batch file. 

__________________________________________________________________________________ 
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Exploring the DS3000 Storage Manager Demo  
 

Executing the Start_Demo.bat initiates a Java session with the Storage Manager Demo program. You’ll 
see the following screens – the DS3000 Storage Manager splash screen identifying the Storage Manager 
Demo followed by the Enterprise Management Window screens: 
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The Enterprise Management Window Task Assistant is a series of wizards that helps you install and 
manage your new DS3000 disk system.  The Task Assistant helps with common tasks such as: 

 Add Storage Subsystems 

 Name/Rename Storage Subsystems 

 Configure Alerts 

 Manage a Storage Subsystem 

Feel free to explore the Task Assistant.  You can auto-discover the storage subsystems by selecting 
Add Storage Subsystem from the Task Assistant, or closing the Task Assistant window  
and clicking on the leftmost icon button in the Enterprise Management Window.   

 

 

__________________________________________________________________________________ 

Note: In subsequent Demo sessions, the storage subsystems may not need to be rediscovered. 
However, if the subsystem status is “unresponsive,” simply delete the systems and rediscover them. 
__________________________________________________________________________________ 

 

In the right panel of the Enterprise Management window, you will see two preconfigured storage 
systems: 1) the DS3400, and 2) the DS3200. 

With two systems, you can select the appropriate subsystem as the basis to demonstrate features:,   

1) The DS3400 is ideal for an in-depth exploration of the DS3000 Storage Manager feature set. 
Nothing is pre-defined for the subsystem, so it can serve as a basis for configuring all the arrays, 
logical drives and host-to-volume mappings, 

2) The DS3200 is suitable for a comprehensive tour of the DS3000 Storage Manager features. It 
includes a number of defined arrays and logical drives.  

Both configurations include a total of 48 SAS drives and 3 EXP3000 drive trays. In addition, all premium 
features, FlashCopy, Volume Copy and partitioning, are enabled. 

It is important to note that the DS3400 and DS3200 are identical in their functionality.  The features and 
tasks presented in the Demo guide can be used interchangeably.  
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Tab Bar Screen Views 
For this initial exploration of the Storage Manager Demo, we will use the DS3400 disk system 
configuration.  

Select the DS3400 system by double-clicking it in the right panel.  This displays the DS3000 Subsystem 
Management window (SMW). 

 

The SMW provides access to most components and functions of the DS3000 series disk systems.  

 

There are five tabs in the SMW view 

 

 



DS3000 Storage Manager Software Demo Guide - 9 - 

 The Summary tab provides access to:  
o Initial Setup Tasks link  
o Recovery Guru - This is the automatic discovery tool for systems problems 
o Hardware components profile and drive location 
o Locate arrays and logical drives - Drive group(ings) and disk system targets (LUNS) 
o Host and mappings - The attachment of LUNs to servers  
o Information center and online help 

 
• The Configure tab provides access to:  

o Configure host access – Automatic or manual 
o Create host group – A group of servers or cluster 
o Automatic storage configuration 
o Configure Hot Spares 
o Create logical drives (including FlashCopy logical drives) 
o Create host-to-logical drive mappings – Server to LUN 

 
• The Modify tab provides access to: 

o Edit host topology - Servers using LUNs 
o Rename or delete logical drives 
o Add free capacity - Drive space available in the arrays and not yet assigned to a logical-drive) 
o Change logical drive ownership (preferred path) - Route from/to server and disk system 
o Modify FlashCopy logical drives - Drive used for FlashCopy 
o Manage logical drive copies - Premium feature of VolumeCopy or logical drive copy 
o Edit host-to-logical drive mappings 

 
• The Tools tab provides access to: 

o Rename storage subsystem 
o Set or change password 
o Change media scan settings - System data block check done in the background 
o Turn on indicator lights for various components to identify them physically (e.g. locate a drive) 
o View/enable premium features 
o Change enclosure ID numbers - Identification number assigned to a expansion unit 
o Synchronize controller clocks 
o Change controller network configuration - Set IP address information 
o Reset battery age - Days until battery replacement should be made 
o Inherit system settings – Leverage already existing array configurations 

 
• The Support tab provides troubleshooting and maintenance access to:   

o Recover from failure 
o View event log 
o Gather support information 
o View storage subsystem profile 
o Download firmware 
o Manage controllers 
o View online help 
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Putting Together an Effective Demo 
 

Selecting a disk system for their organization can be a difficult decision for customers. It is also not 
always clear what criteria or requirements are behind their selection process.  The DS3000 Storage 
Manager Demo is one means for you to understand your customers buying criteria. This Demo leads to 
open discussion with your customer as you go through the simulator together. By reviewing with them 
what they are likely to experience with the DS3000 disk systems and DS3000 Storage Manager, you can 
work with them to define what features are most important to them and why.  

An effective way to win over the prospect is to provide training to the eventual administrators and 
managers of the IBM DS3000 disk systems.  This will show the ease of use of the DS3000 Storage 
Manager as well as address any of their concerns about learning a new software system.  Stressing the 
task-oriented user interface and its simplicity, this training can be tailored to the specific needs of the 
group you are training: 

 Initial set-up and configuration 

 Basic operations for their particular environment 

 Advanced premium features for when they need them 

 Specific operations for growing their disk system 

 Application specific tips and techniques 

This course is best held as an interactive exchange of “How do I…?” topics and exercises that provide 
best practices for common tasks that DS3000 Storage Manager offers.  

This strategy has been used successfully on numerous occasions in parallel with the pre and post sales 
process.  It’s an excellent vehicle to train, practice, and sell. 
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Scenarios 
The following sections will provide some scenarios for you to engage with your customers and how to 
address a specific business issue utilizing the DS3000 Storage Manager functions. As well, you may 
decide to highlight some of the features you have found in addition to the demo guide and develop your 
own scenarios. 

 

Scenario 1 – “This is my first external storage system. What do I do?” 
Initial Setup Tasks dialog box 
 

The DS3000 Storage Manager’s Initial Setup Tasks 
dialog box provides step-by-step instructions on 
setting up a DS3000 disk system.  As a task-based 
user interface, it provides a more obvious starting 
point to setting-up and managing the disk system.    

The Initial Setup Tasks window offers a step-by-
step process of tasks directing users to complete an 
initial configuration.  It pops up automatically when 
the SMW is first brought up, or can be launched by 
selecting Perform Initial Setup Tasks from the 
summary tab of the SMW.  

The steps listed as initial setup tasks include: 

1. Locate the storage subsystem 

2. Rename the storage subsystem 

3. Set a storage subsystem password 

4. Configure host access  

5. Configure storage subsystem 

 

In this scenario we will cover each step in the initial 
setup tasks list.  
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Step 1.  Locate the Disk System  
 
This optional step helps locate the subsystem if it’s in a data center or room with other systems. Click on 
Locate the Storage Subsystem, which will take you to the following screen:  

 

 
 

From this screen, select an item and click on Locate to have the lights on the DS3000 disk system 
indicate its location. This allows you to locate the physical location of the disk system in your network.  
The disk system can then be identified with a label.  

 

Step 2. Rename the Storage Subsystem 
 
This optional step allows you to rename the subsystem. Click on Rename the Storage Subsystem, 
which will take you to the following screen. 
 

 
 
Enter the new subsystem name and click OK.  
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Step 3: Set a Storage Subsystem password 

This optional step allows you to set a password for the subsystem, so that unauthorized users can not 
make changes. Click on Set a Storage Subsystem Password, which will take you to the following 
screen.  

 
 

Enter and confirm the new password, then click OK. 

 

Step 4. Configure Host Access   

This step allows you to provide one or more hosts access the subsystem. Select Configure Host 
Access, which will direct you to the following window.  
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After selecting the appropriate host, click Add and then OK.  You will then receive confirmation of host 
access.  

 

__________________________________________________________________________________ 

Note: In the Demo, several hosts have been pre-configured for access. 
__________________________________________________________________________________ 

 

Step 5. Configuration Storage Subsystem   

This step has multiple options.  The Automatic (Simple) option is the quickest and easiest, but provides 
the least amount of control over the configuration. The Manual (Advanced) option, which still provides 
some automated assistance, provides more control over the configuration and will be preferred in nearly 
every situation. This scenario will cover the automatic option. The Manual (Advanced) option, Create 
Logical Drives, will be covered in Scenario 2. 

 

Automatic (Simple) 

Expand the Automatic (Simple) option under Configure the Storage Subsystem and select Step 1: 
Automatic Configuration. This will bring you to the Automatic Configuration window where you will 
simply choose a RAID level and click Finish. Storage Manager will then configure the entire subsystem 
into multiple arrays based on the selected RAID level and create a single logical drive within each array.  

________________________________________________________________________________ 

Note: Users that wish to define the number of drives in each array, and the number and size of the 
logical drives in each array, should use the “Create Logical Drives” option. 
________________________________________________________________________________ 
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After reviewing your configuration options with RAID 5, return to the task window and select the second 
step in the Automatic option - Create Host-to-Logical Drive Mappings. This will open the Create Host-
to-Logical Drive Mappings window.  

 

Select the host you would like to map and click Next.  
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Select the logical drives you wish to be mapped to the host and click Finish.  

 
 

If more than one logical drive is selected, the logical unit number will be assigned automatically. If only 
one logical drive is selected, you will also be prompted to assign it a logical unit number (see below). 

 
 

After this process has been completed, click OK and you will be informed if the host-to-logical drive 
mapping was a success and you would be able to map another host-to-logical drive. For this example, 
select NO. 
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You have successfully created arrays, logical drives and mapped logical drives to a host with the simple 
Automatic option.  
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Scenario 2 – “I have newly added drives that I would like configure” 
Logical Drive Creation 
 

Like many configuration tasks within Storage Manager, logical drive creation can be an Automatic or 
Manual task. We will review the Automatic (recommended) selection to demonstrate the simplicity and 
ease of this task. The Manual option is covered in the Advanced Scenarios section on page 39.    

 

From the Configure tab, or from the Initial Setup Tasks window under the Manual (Advanced) option, 
select Create Logical Drives. This will take you to the Create Logical Drives – Select Capacity Type 
window to decide on the type of capacity you wish to use.  

 

 
 

Select Unconfigured Capacity and click Next.  
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You will then be offered the option of Automatic or Manual configuration.  Select Manual and Next. 

 

At the Create Logical Drives – Specify Capacity window, first select the RAID level desired.  You will 
then see a list of array options based on the number and type of drives in the configuration. From this list, 
select the array that has the attributes desired and click Next.  
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The next window, Create Logical Drives – Specify Logical Drive, requires you to select the logical drive 
capacity from the free capacity that is available, name the logical drive and identify its I/O characteristics.   
We will select 200GB capacity, name the logical drive Marketing and select the I/O characteristics based 
on a file system application.  
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The Create Logical Drives – Map Logical Drive to Host window will allow you to map your logical drive 
to a host group or individual host. We will map it to Host Stanley and assign it LUN one. Click Finish.  

 
 

You will receive confirmation that the creation of your logical drive has been completed! 
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Scenario 3 – “I want to protect against a failed drive” 
Automatic Hot Spare Drive Configuration 
A Hot Spare Drive is an unassigned drive which automatically replaces a member of an array if a drive 
fails. The Hot Spare Drive adds another level of data protection by acting as a “reserve” drive in the 
instance of a drive failure.  

From the Configure tab, select Configure Hot Spares.  

 

As it is important to emphasize the ease of use of the DS3000 Storage Manager, we will demonstrate the 
Automatic option.  Therefore, at the next window, Configure Hot Spares, we will select Configure Hot 
Spares (Automatic).  
 

 
 
 



DS3000 Storage Manager Software Demo Guide - 23 - 

___________________________________________________________________________________ 

Note: Use the Create Hot Spare (Manual) when assigning specific drives or viewing/making changes to 
the current hot spare coverage. The manual process is covered in the Advanced Scenarios section on 
page 37. 
____________________________________________________________________________________ 

 

This will bring you to the Configure Hot Spares (Automatic) window.  This option will automatically 
assign the proper number of hot spare drives required to provide optimal coverage for the storage array.  

 

Select Assign and you will be informed if this task was completed. 

 
 

The above screen shot will provide confirmation of the number of hot spares that have been configured.  
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Scenario 4 – “How do I add capacity to an array?” 
Expanding Drive Capacity (Dynamic Array Expansion) 
The DS3000 Storage Manager provides an easy method to expand the capacity of an array by simply 
adding more drives to it. This provides additional performance and capacity to the array. You can 
demonstrate the ease of adding additional capacity with the DS3000 Storage Manager by demonstrating 
the following steps.  

First, select the Modify tab. Click on Add Free Capacity (Drives).  

 

The window, Add Free Capacity (Drives) – Selected Array, will then prompt you to select the array that 
you wish to expand. Click Next. 
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And you are almost there!  At the Add Free Capacity (Drives) – Select Capacity screen, the DS3000 
Storage Manager will provide some status information about the array you selected.  From here you can 
add one or two drives to the existing array (note: this process can be repeated if desired). Click Finish.  

 

And the process of adding free capacity starts.  

 

__________________________________________________________________________________ 

Note: This operation will take an extended period of time to complete and you cannot cancel it once it 
starts, however, the data on the volume group will remain accessible. 
__________________________________________________________________________________ 
 

You can monitor the process of this operation by viewing the volume and array displays. 
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DS3000 Storage Manager Premium License Features 
The Premium Feature Licenses offered with the DS3000 Storage Manager includes Partitioning, 
FlashCopy and Volume Copy.  

These features can be viewed and enabled by accessing the Tools tab on the main tool bar.  

As you can see in the following window, all Premium Features have been enabled. For these Premium 
Features to be enabled, a Feature Enable Identifier was entered.  This Feature Enable Identifier is 
provided when the Premium Feature Storage Pack or Premium Features license was purchased.  

 

The following scenarios will help guide you when to recommend a specific feature as well as the process 
of how to utilize the feature with the DS3000 Storage Manager.  
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Premium Feature Scenario 1 – “How can I share capacity across my 
hosts?” 
Storage Partitioning  
Storage partitions are created when you define Host-to-logical Drive Mappings. Partitioning allows 
administrators to create multiple virtual systems from a single DS3000 series disk system. Each partition 
represents a virtual disk system and consists of one or more logical drives assigned to an individual 
server or group of servers.  

Create Host-to-Logical Drive Mapping can be administered by going to the Configure tab. At the 
Configure window, select Create Host-to-Logical Drive Mappings.  

 

This will open the Create Host-to-Logical Drive Mappings - Select Host window.  

 
 

Select the host you would like to map and click Next. This will take you to Create Host-to-Logical Drive 
Mappings – Select Logical Drives screen in which you select the logical drive(s) you wish to be mapped 
to the host.  

__________________________________________________________________________________ 

Note: Unmapped logical drives will need to be created to demonstrate this feature. 
__________________________________________________________________________________ 
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If more than one logical drive is selected, the logical unit numbers will be assigned automatically. If only 
one logical drive is selected, you will also be prompted to assign it a logical unit number. 

Select Finish following your logical drive selection.  

    
 

After this process has been completed, click OK. You will then be informed if the host-to-logical drive 
mapping was a success and if you would like to map another host-to-logical drive. For this example, 
select NO. 

You have successfully mapped a host to a logical drive! 

 

 



DS3000 Storage Manager Software Demo Guide - 29 - 

Premium Feature Scenario 2 – “How do I improve my application service 
levels with hot backups?” 
FlashCopy  
One significant business problem that the IBM DS3000 Storage Manager solves is the ever-increasing 
time to complete a backup of today’s applications.  As data grows, the time to back it up also grows. The 
difficulty of provisioning time for backups in a 24x7 environment is challenging for administrators.   

The DS3000 Storage Manager’s FlashCopy feature solves this problem by minimizing the amount of 
time application I/O must be suspended, or the amount of time the application is in hot backup mode.   

Instead of impacting the application for the length of the backup process, FlashCopy is used to create a 
nearly instantaneous image of the source data. Then, the application can come out of hot backup mode 
and resume normal processing while the backup application begins copying the point-in-time FlashCopy 
to the desired target.  

FlashCopy can be used to create a point-in-time image of any standard logical drive at any time, as long 
as there are no tasks (such as rebuilds or expansions) in process on that logical drive.  

A simple demonstration of the DS3000 Storage Manager’s FlashCopy function will show the benefits of 
reducing the impact of lengthy backups.  

Once the FlashCopy feature is enabled (see page 26), go to the Configure tab and select Create 
FlashCopy Logical Drives.  

  

_____________________________________________________________________________ 

Note: You must refer to the specific instructions in online help for your host OS before creating a 
FlashCopy. Failure to complete the steps listed for your host OS may result in loss of FlashCopy data 
consistency.  You will also receive a dialog box reminding you of this before you proceed. 
_____________________________________________________________________________ 
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At this selection, you will be directed to the Create FlashCopy Logical Drives - Select Base Logical 
Drive window.  Select the logical drive which you would like you would like a FlashCopy image of.   

 

Also note that when you create a FlashCopy logical drive, you automatically create FlashCopy Repository 
logical drive.  A FlashCopy Repository logical drive stores information about the data that has changed 
since the FlashCopy logical drive was created. Repository logical drives are reserved for DS3000 Storage 
Manager use. For example, you cannot select a FlashCopy Repository logical drive for use as a base 
logical drive or as a target logical drive in a FlashCopy or VolumeCopy operation.  

 

After your logical drive selection, you will be asked to select a path. You have the choice of taking the 
Simple setup, or the Advanced setup for more control over the FlashCopy parameters. For this example 
and to demonstrate the intuitive and simple nature of the DS3000 Storage Manager, we will select the 
Simple option.   
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You will then be able to change the default logical drive names if desired.  

 

Once you specify the appropriate names and click Next, you will select which host or host groups you 
would like the FlashCopy mapped to. 
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After selecting the host or host group mapping, assign a LUN and Finish. 

 

This will complete your FlashCopy logical drive creation. A Summary screen will open which shows 
summary information regarding the logical drive and the FlashCopy point-in-time image.  
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Premium Feature Scenario 3 – “How can I create an independent copy of 
my data?” 
VolumeCopy  
Another premium feature of the DS3000 Storage Manager is VolumeCopy. VolumeCopy creates a 
complete physical copy, or a clone, of a logical drive within a disk system. The clone is a unique entity 
that can be assigned to any host and used by applications requiring a point-in-time (PiT) copy of 
production data – without affecting the performance of that production data. This feature is typically used 
in conjunction with FlashCopy to provide an independent copy of a point-in-time FlashCopy logical drive.  

Once the VolumeCopy feature is enabled (see page 26), go to the Configure tab and select Create 
Logical Drive Copies. 

 

You will then be directed to the Create Logical Drive Copies – Select Source Logical Drive window.  
Select the logical drive you wish to copy.   

 



DS3000 Storage Manager Software Demo Guide - 34 - 

You will then be directed to the Create Logical Drive Copies – Select Target Logical Drive.  Select the 
logical drive that will be the target copy and click Next.   

____________________________________________________________________________________ 

Note: Starting the copy process will overwrite all existing data on the target logical drive as well as place 
the source logical drive READ-ONLY mode during the copy. Therefore, best practice is to copy a 
FlashCopy image, which will maintain access to the production data. 
____________________________________________________________________________________ 

The Create Logical Drive Copies – Set Copy Priority window will then appear which gives you the 
ability to change the copy priority to designate how the disk system resources should be used when 
creating the copy.  This enables your customers to minimize either copy time or the overall I/O impact to 
their disk system 
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Move the priority bar between Lowest and Highest and click Next.  

The final window, Create Logical Drive Copies – Confirm Copy Settings, reviews the source logical 
drive, target logical drive and priority settings you have selected.  Again, as this will overwrite all existing 
data on the target logical drive and make the target logical drive read-only, it is important to ensure that 
these settings are correct.   

 

At the available prompt, type yes and select Finish. The VolumeCopy finishes in a short period of time.  

 

And your VolumeCopy has been created! 
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 Advanced Features and Manual Functions 
The remainder of the DS3000 Storage Manager Demo guide is intended to highlight some of the more 
advanced and manual features that this Storage Manager offers.  As the key selling point of the DS3000 
Storage Manager is its ease of use and intuitive interface, many of your customers will not see a need for 
these advanced features for their organization.   

However, the DS3000 disk systems may be sold to an organization with experienced IT staff that may 
want to take advantage of these features or “take the wheel” in creating the specific configurations they 
have in mind versus an pre-set configuration that is offered through the automatic options.  As well, as 
your organizations become more savvy and comfortable with the Storage Manager, they may request this 
additional functionality that is available to them.  
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Manual Hot Spare Configuration 
 

The manual Hot Spare configuration option is especially useful for assigning specific drives or 
viewing/making changes to the current hot spare coverage. 

From the Configure tab, select Configure Hot Spares.  You will then be directed to the Configure Hot 
Spares window.  Select Configure Hot Spares (Manual). 

 

The Configure Hot Spares (Manual) screen provides the current hot spare drives in use and prompts 
you to select the drive type you wish to assign as the new hot spare drive.  

 

For this example, select the 142.8GB SAS disk drive, and click Assign.  
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A dialog box, Assign Hot Spares, will open up and provide the available disk drives that are available 
and fit the type of drive and capacity you specified.  Select the desired drive and click OK.   

 

 
 

And you have completed the manual configuration of a Hot Spare drive.  
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Manual Logical Drive Configuration 
As we have previously created logical drives via the Automatic option on page 18, lets review the 
Manual (Advanced) option.  

 

From the Configure tab, select Create Logical Drives.  

 
 

This will then prompt you to the Create Logical Drives – Select Capacity Type screen which allows you 
to choose capacity from either unconfigured capacity or free capacity from an existing array. Select 
Unconfigured Capacity and click Next.  
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From the Create Logical Drives - Drive Selection Choices window, select Manual (Advanced) and 
click Next. 

 

You’re then taken to the Create Logical Drives - Manual Drive Selection window. Select the desired 
drives and Add them to the array.  

 

Once all the drives are selected, select Calculate Capacity to ensure the proposed array will be your 
capacity and channel protection requirements. Then click Next. 
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Once the array is created, the Create Logical Drives – Specify Logical Drive window comes up and the 
logical drive capacity, name and I/O characteristics are defined.  
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The Create Logical Drives – Map Logical Drive to Host window will allow you to map your logical drive 
to a host group or individual hosts. As this is the first logical drive to be mapped, we will assign it to LUN 
number one, Finish.  

 

And you will receive confirmation that the creation of your logical drive has been completed! 
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Media Scan Settings 
 

The DS3000 Storage Manager provides the ability to perform a background scan of media to ensure data 
integrity.  On the Tools tab select Change Media Scans Settings.  

 

At the Change Media Scans Settings dialog box select the logical drives (one or more) to scan and their 
settings (scan duration and with or without redundancy check). Media scans can also be suspended from 
this window. Click OK and the operation begins.   
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Command Line Interface 
While not well suited for the part-time administrator, there is a command line interface (CLI) for the 
DS3000 disk systems. It is accessed from the Enterprise Management Window under Tools.  

 
 
This will open up the script editor. 

 
 

Direction on how to create a script is beyond the scope of this demo guide.  
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